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Safety Compliance

Safety Statement
This equipment has been tested to comply with USA and Canadian safety certifications in accordance with the specifications of UL Standards: UL60950-1:2007, 2nd Edition and 
canadian CAN/CSA C22.2 60950-1-07, 2nd Edition. Avid Inc. has been authorized to apply the appropriate UL and CUL mark on its compliant equipment. 

Warning

Important Safety Instructions

1) Read these instructions.

2) Keep these instructions.

3) Heed all warnings.

4) Follow all instructions.

5) Do not use this equipment near water.

6) Clean only with dry cloth.

7) Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.

8) Do not install near any heat sources such as radiators, heat registers, stoves, or other equipment (including amplifiers) that produce heat.

9) Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two blades and 
a third grounding prong. The wide blade or the third prong are provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the 
obsolete outlet.

10) Protect power cords from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit from the equipment.

11) Only use attachments/accessories specified by the manufacturer.

12) For products that are not rack-mountable: Use only with a cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the equipment. When a cart is used, use 
caution when moving the cart/equipment combination to avoid injury from tip-over.

13) Unplug this equipment during lightning storms or when unused for long periods of time. 

14) Refer all servicing to qualified service personnel. Servicing is required when the equipment has been damaged in any way, such as power-supply cord or plug is damaged, liquid 
has been spilled or objects have fallen into the equipment, the equipment has been exposed to rain or moisture, does not operate normally, or has been dropped.

15) For products that are a Mains powered device: 
The equipment shall not be exposed to dripping or splashing and no objects filled with liquids (such as vases) shall be placed on the equipment. 

Warning! To reduce the risk of fire or electric shock, do not expose this equipment to rain or moisture. 

16) For products containing a lithium battery: 
CAUTION! Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type. 

17) For products with a power switch: 
The main power switch is located on the back panel of S3. It should remain accessible after installation. 

18) The equipment shall be used at a maximum ambient temperature of 40° C.
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Introduction

Welcome to the Avid S3 studio controller and Ethernet AVB 4 in/6 out audio interface from Avid®. The S3 uses Avid’s high-speed 
EUCONTM (Extended User Control) protocol to enable fully integrated control of Pro Tools® and other EUCON-compatible audio 
and video applications via an Ethernet connection. The same Ethernet connection also provides Ethernet AVB audio connections 
between the on-board audio I/O on the S3 and the workstation computer. 

This guide shows how to install the S3 and EuControl software, provides an overview of the control surface, and shows how to use 
the S3 on-board I/O. 

After installing the Dock and EuControl software, see the Using EuControl Surfaces.pdf for instructions on how to use S3 and other 
Avid media controllers to record, edit, and mix in Pro Tools. Thanks to the EUCON protocol, most steps for Pro Tools are also ap-
plicable in other EUCON-aware applications from our development partners, including Ableton Live, Logic Pro X, Cubase, Nu-
endo, and more (see the EUCON Application Setup.pdf to learn how to set up EuControl communication with these applications). 

The S3, when connected to an E3 engine and up to four Stage 16 remote stage boxes, is also the central controller for the 
VENUE | S3L-X live digital mixing system.

EuControl Software
EuControl lets your workstation computer find, link, and communicate with the S3 via the EUCON protocol. Eu-
Control also lets you set preferences for and customize the controls on your S3. EuControl software must be installed 
on the workstation computer before you can use the S3 with your application. You can also control applications on 
a secondary workstation computer by installing the separate EUCON Workstation software.

Ethernet AVB Audio
(AVB-compatible Mac Running OS X 10.9.x and Higher Required)

Ethernet AVB audio is a high-fidelity, low-latency Ethernet audio protocol used to connect the on-board audio I/O on S3 to your 
Core Audio- and AVB-compatible workstation computer. AVB audio must be enabled on the workstation computer before you can 
use the I/O on the S3 with your applications. See S3 Audio I/O for more information.

See the VENUE | S3L-X System Guide for more information.
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What’s Included
• S3 control surface

• Power supply with IEC cable

• Cat5e (350 MHz) Ethernet crossover cable

• Documentation pack, which includes the EuControl software Activation Card, S3 Welcome Letter, Health and Safety Guide and 
a warranty card

Optional Equipment
• A standard Ethernet router or switch (for control surface functionality only)

• A qualified AVB-compatible Ethernet switch (for audio I/O and control surface functionality)

System Requirements and Compatibility
One S3 control surface can be used with EuControl Software at a time. One S3 can be used in conjunction with the 
Pro Tools | Control app for iPad (not included) and one Pro Tools | Dock. When no Pro Tools | Dock is present, S3 can be used with 
one Artist Transport at a time. 

Avid can only assure compatibility and provide support for hardware and software it has tested and approved. For compatibility in-
formation and other resources, visit:

http://avid.force.com/pkb/articles/compatibility/EuControl-Compatibility

Registration
Review the enclosed Registration Information Card and follow the instructions on it to quickly register your purchase online. 
By registering, you become eligible to receive the following:

• Technical support information

• Software update and upgrade notices

• Hardware warranty information

About This Guide
This guide covers using the S3 control surface with Pro Tools and other EUCON-compatible applications. 

Conventions Used in This Guide
All of our guides use the following conventions to indicate menu choices and key commands:

The names of Commands, Options, and Settings that appear on-screen are in a different font. 

If you bought the S3 as part of a VENUE | S3L-X system, see the VENUE | S3L-X System Guide for information on what is included.

For applications that only support MackieControl, see the EUCON Application Setup Guide.pdf..

Convention Action

File > Save Choose Save from the File menu

Control+N Hold down the Control key and press the N key

Control-click Hold down the Control key and click the mouse button

Right-click Click with the right mouse button
 Introduction 2
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The following symbols are used to highlight important information:

Hardware Switches on S3 Control Surface
The names of switches on the S3 control surface are in bold, such as Sel. The two Surface SHIFT switches on the S3 are indicated 
by bold text, in all-caps to distinguish it from references to the Multi Select/SHIFT Global Modifier switch and the Shift key on 
your computer keyboard.

Accessing Secondary Functions Using Surface SHIFT
The Surface SHIFT switches on the S3 are used in conjunction with other switches to access a secondary layer of functions. The 
secondary functions of some switches are highlighted in gray above the primary function (such as < Bank/Home, where Home 
is the secondary function). Other switches have secondary functions that are not labeled on the surface. Read this guide to learn how 
to access all secondary functions. 

The following terminology is used to describe Surface SHIFT functions.:

Example:

• “Press and hold the Surface SHIFT switch then press the Bank/Home switch”

is written as

• “Press Surface SHIFT + Bank/Home”

Momentary or Latching SHIFT

By default, the Surface SHIFT switch operates in momentary behavior (active only while pressed and held down). 

You can change this to operate in Latching behavior in the Preferences tab of EuControl Settings. 

User Tips are helpful hints for getting the most from your system.

Important Notices include information that could affect your data or the performance of your system.

Shortcuts show you useful keyboard or mouse shortcuts.

Cross References point to related sections in this guide and other Avid guides.

Surface SHIFT switch (left) and the Multi Select/SHIFT switch (right)
 Introduction 3



How to Use this PDF Guide
These are some useful features of this PDF:

• The Bookmarks on the left serve as a continuously visible table of contents. Click a + symbol to expand that heading to show 
subheadings. Click the – symbol to collapse a subheading. Click on a subject heading to jump to that page.

• The Table of Contents provides active links to their pages. Select the hand cursor, allow it to hover over the heading until it 
turns into a finger. Then click to locate to that subject and page.

• Any text entry in blue is an active link. Click on the link to go to that section.

• Select Find from the Edit menu to search for a subject.

Resources
The Avid website (www.avid.com) is your best online source for information to help you get the most out of your Avid system. 
The following are just a few of the services and features available. 

Account Activation and Product Registration
Activate your product to access downloads in your Avid account (or quickly create an account if you don’t have one). Register your 
purchase online, download software, updates, documentation, and other resources. 

https://www.avid.com/account

Support and Downloads
Contact Avid Customer Success (technical support); download software updates and the latest online manuals; browse the Com-
patibility documents for system requirements; search the online Knowledge Base or join the worldwide Avid user community on 
the User Conference. 

https://www.avid.com/products/pro-tools-s3/learn-and-support

http://avid.force.com/pkb/articles/faq/S3-Surface-Support-FAQ

Products and Developers
Learn about Avid products; download demo software or learn about our Development Partners and their plug-ins, applications, and 
hardware. 

https://www.avid.com/Products/index.html

Get Started Fast Video Tutorials
Watch the latest video tutorials for the Control app, Dock, S3, and other EuControl products on YouTube: 

S3 + Dock Integrated Workflows

For earlier EuControl hardware and software videos, watch the Get Started Fast videos: 
Get Started Fast with Pro Tools | S3 and Dock

You can find more videos, including the latest workflow tutorials, on the Avid website. Go to www.avid.com, view Products and 
select Pro Mixing. Follow the links for your controller and check the Learn and Support listings for video resources. 
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Installation and Setup

This chapter shows how to get your S3 set up as a studio control surface, and consists of the following steps:

Connecting S3
First, connect your S3 directly to your workstation computer (the computer running Pro Tools or other DAW), or connect to a 
router that is then connected to your workstation computer, then power on S3.

To connect your S3 to your workstation computer:

1 Connect the female end of the AC power cord into the power adapter and the male end into a power outlet. Make sure the AC 
power cord is pushed all the way into the adapter.

2 Connect the DC output cable from the power adapter to the DC In jack on the back panel. 

• Connecting S3

• Installing EuControl Software

• Enabling EUCON in Pro Tools

• Confirming EUCON

Standard routers and switches can be used if you are using the S3 only as a control surface. However, to use the built-in AVB 
audio I/O on the S3, the S3 must be connected directly to the computer or to an AVB-compatible Ethernet switch. Visit 
www.avid.com/compatibility for information on compatible peripherals.

Connecting the AC power cable to the power adapter

Connecting the DC power output cable to the DC In jack
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3 Connect one end of an Ethernet Crossover cable into Network port A on the back panel of the S3. 

4 Connect the other end of the Ethernet cable to an available Ethernet port on your computer, or to the computer’s Thunderbolt 
port using an Ethernet-to-Thunderbolt adapter.

5 If you want to connect the S3 to a local area network, or to connect an Artist Transport, connect the Ethernet cable to an Ethernet 
router or switch, and make sure the router or switch is powered on before powering on the S3.

6 If you are connecting to a Mac with two Ethernet ports, we recommend you use Ethernet 1 rather than Ethernet 2. However, if 
you want to use Ethernet 2, do the following on your computer: 

• On the workstation computer, go to System Preferences > EUCON. 

• Click the Network Interface pop-up menu and choose Ethernet 2.

7 Press the power switch on the back of the S3 to the “on” position. The faders jump and the LEDs blink during initialization.
 

8 When the S3 is finished initializing, confirm that the S3 is in Studio Mode, indicated by Studio Mode appearing in the 15th 
top-row encoder display. 

9 Do one of the following depending on the S3’s current mode:

• If the S3 is in Studio Mode, proceed to Installing EuControl Software.

• If Live Mode is shown in the display instead of Studio Mode, proceed to Toggling Studio and Live Modes.

Network port A on the back panel of the S3

If your system includes a Dock and an S3 you can connect the Dock to Network port B on the S3, and connect S3 network port A 
to your workstation. (S3 and S1 cannot be used simultaneously.) 

An Ethernet-to-USB adapter may also be used, but audio I/O to and from the S3 is not supported.

S3 cannot connect to your workstation computer using a wireless connection. A hard-wired network connection is required.

Top-row encoders showing Studio Mode enabled

If the S3’s current mode does not appear in the two encoder displays after the S3 is powered on, the firmware on your S3 must be 
updated via VENUE Software 4.5 or higher. Connecting the S3 to an E3 engine with VENUE 4.5 or higher installed and powering 
on both devices automatically updates the firmware on the S3. See the What’s New in VENUE 4.5 Guide for more information.

12V DC

Studio Mode
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Toggling Studio and Live Modes
The S3 operates in one of the two following modes:

Studio Mode Lets you use the S3 with your workstation computer after EuControl software has been installed. If the S3 is in Stu-
dio Mode and is connected to an E3 engine (for use in an S3L live mixing system), the S3 will not be recognized by any E3 engines 
in the network.

Live Mode Lets you use the S3 with an E3 engine as part of an S3L live mixing system. If the S3 is in Live Mode and is connected 
to a workstation computer with EuControl software installed, the S3 will not be recognized by EuControl on the workstation com-
puter.

You can toggle the S3 between modes using the Application/Workstation switch.

To toggle between Live and Studio modes:

1 Power off your S3.

2 Press and hold the Application/Workstation switch, then press the power switch on the back of the S3 to the “on” position.

3 Keep holding the Application/Workstation switch until the two rightmost top row encoder displays (encoders 15 and 16) 
show Live Mode/Studio and OK, respectively.

4 Press the encoder under the display showing Live Mode/Studio once, so that the desired mode appears above and in larger text 
than the other mode in the display. 

5 Press the encoder under the display showing OK. The S3 restarts automatically in the selected mode.

Top-row encoder displays showing mode toggle controls

Encoder display showing Studio Mode enabled

12V DC

...then press the S3 power switch to “On”Press and hold the Application/Workstation switch... 

Top

In

Sel

In

Sel

Config
Back

PageExpnd
Page

Live Mode
Studio

OK

Studio Mode
Live
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Installing EuControl Software
Next, install EuControl software on your workstation computer. An Internet connection is required to download EuControl.

To install EuControl software: 

1 Visit www.avid.com/account and log into your Avid account (or create an account if you don’t already have one) to download 
the EUCON_WorkstationUnifiedInstall installer for your workstation computer’s platform (Mac or Windows). If you do not see 
EuControl software in your account go to avid.com/redemption and click on EuControl.

2 When download is complete, locate the EUCON_WorkstationUnifiedInstall on your computer and double-click it to mount it 
(DMG on Mac) or uncompress it (ZIP for Windows), then launch the installer.

3 Follow the on-screen prompts until the Installer list is displayed (as shown at right). For a description of each option, select it 
(Mac) or hover the mouse over it (Windows only). 

4 Select each option you want to install:

• To only install EuControl, select S1/S3/Dock/Control/Artist Series.

• If you have already installed EuControl on your primary workstation and
now want to install onto an additional, external workstation, select EU-
CON Workstation. (See also Connecting a Second Workstation).

5 Click Continue (Mac) or Next (Windows), then click Install. 

When reminded that a restart is required, click Continue Installation (Mac) 
or Yes (Windows). 

6 When installation is complete click Restart. 

After your computer restarts, EuControl software launches automatically 
and is running when its icon (which is unlit until the Control app is con-
nected) appears in the Menu bar (Mac) or the System tray (Windows). 

7 If the lit EuControl icon does not appear, do any of the following: 

• See Add to add S3 manually.

• Click the unlit EuControl icon and choose Restart EUCON Applications.

• Shut down S3 and your computer, then turn them on (S3 first, then the workstation computer).

• See www.avid.com/S3-Surface-Support for the most current troubleshooting information.

8 Proceed to Updating S3 Firmware.

To uninstall items: 

1 Launch the installer. Items that are currently installed are selected (checked) and indicated as Installed. 

2 Do the following: 

• To uninstall a specific component, make sure it is not selected (no check mark).

• To uninstall all EUCON applications, select Uninstall all applications.

• To uninstall all User Preferences, select Uninstall User Preferences (your appsets will not be removed).

3 Click Continue (Mac) or Next (Windows). 

On 10.14/”Mojave” (only) you might need to add Pro Tools and EuControl to the Privacy list in System Settings. 

Unlit EuControl icons on Mac (left) and Windows (right)

Installing EUCON Workstation software 
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AutoLaunch Settings
You can enable or disable auto-launch for EuControl, WSControl, and/or XMON using the new AutoLaunch selector. 

To configure AutoLaunch on Mac: 

1 Make sure EuControl or S6 WSControl is installed, then do the following: 

Mac  Click on the EuControl or WSControl icon in the menu bar. 

Windows Right-click on the EuControl or WSControl icon in the System Tray at the bottom of the screen. 

2 From the Auto-launch Apps sub-menu, choose any of the following (you can enable more than one):

• EuControl (for S3, S1, Dock, Avid| Control, and Artist Series)

• WSControl (for S4/S6)

• MTRX

• XMON

EuControl Auto-launch Apps selector (macOS shown)
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Updating S3 Firmware
After installing EuControl, make sure your S3 is running the latest firmware. The firmware is provided within EuControl, so an In-
ternet connection is not required. 

To update S3 firmware:

1 Click (Mac) or double-click (Windows) the EuControl icon and select EuControl Settings.

2 If necessary, click Surfaces to display the Surfaces tab.

3 Click Avid S3 in the My Surfaces list so it is highlighted. 

4 Click Update Firmware. If the Update Firmware dialog shows a message that the surface is up to date, no further action is nec-
essary. 

5 If the firmware needs to be updated, follow the instructions in the Update Firmware dialog box to proceed, and make sure to ob-
serve the following guidelines when updating firmware:

• Ensure that S3 is connected to a trustworthy power source.

• Do not power off the S3 during the update or attempt to interrupt the update.

The status of the firmware update is shown on the S3 displays as well as in the EuControl dialog. 

6 Click Done when the firmware update is complete, then proceed to Enabling EUCON in Pro Tools. 

Surfaces tab (Dock shown)

If S3 does not appear in the My Surfaces list, add it manually. See 3– Add.
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Overview of the Surfaces Tab
The Surfaces tab in EuControl Settings shows all EUCON controllers on your network and those connected to your instance of Eu-
Control. Use the Surfaces tab to add and connect surfaces, arrange them in the desired order, pair S1s with Control app tablets and 
manage Control app Master/Meters/Hybrid designation. 

The Surfaces tab provides the following lists and controls. 

1– All Surfaces
All Surfaces shows all Avid media controllers on the network. A device shown in light gray is already connected either to your own 
or another instance of EuControl running on a different workstation. In both cases, it is not selectable.

2– My Surfaces
My Surfaces shows the media controllers connected to your instance of EuControl. The Type column shows an icon for each de-
vice. The Surface or Master Tablet column shows the name of the device, and for tablets indicates which Avid Control app is func-
tioning in Master mode. The top-to-bottom order corresponds to the left-to-right order of the surfaces, respectively. The leftmost 
surface is assigned to fader strip 1. Use the up and down arrow buttons (located to the right of My Surfaces) to reorder the list. Each 
media controller can be renamed by double-clicking the existing name and typing a new name.

3– Add
Click Add to add the selected All Surfaces entry to My Surfaces. This connects the selected Avid media controller to your instance 
of EuControl. You can also click and drag an Avid media controller from All Surfaces to My Surfaces. Add is disabled if all media 
controllers in All Surfaces are connected to any instance of EuControl.

4– Remove
Click Remove to remove the selected surface from My Surfaces and make it available to other instances of EuControl.
Remove is disabled if no surface is selected.

5– Show Info
Select a unit in All Surfaces or My Surfaces and click Show Info to see the name of the device (and currently linked Control app, 
if any), hardware and software information, or troubleshooting suggestions. 

6 – Update Firmware
Click Update Firmware to check and, if necessary, update firmware on the hardware control surface currently selected in 
My Surfaces. This setting does not apply to Avid Control. 

Surfaces tab showing the Avid Control app in All Surfaces (at left) and added to the My Surfaces list (at right)

1 2

3

4
5

6
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Select a single media controller in the My Surfaces list. Click Update Firmware to update that unit’s firmware. If a dialog displays 
a message that the firmware is up to date, no further action is necessary. Repeat for any additional hardware controllers. 

The firmware is embedded in EuControl so an Internet connection is not required. 

Follow the instructions in the EuControl dialog box.

• The media controllers must be plugged into a working power source.

• Do not power off any media controllers during the update or attempt to interrupt the update.

• The status for each media controller being updated is displayed on that device as well as in the EuControl dialog.

Artist Control Banks Independently
(Artist Control Only)

This option is only available when an Artist Control is selected in the My Surfaces list. When enabled, each Artist Series unit can 
bank independently of each other. In applications that support it, this lets you configure one unit for dedicated control of output bus-
ses, for example.

Enabling EUCON in Pro Tools 
When you first connect your S3, you must enable EUCON in Pro Tools, EUCON subsequently remains enabled in Pro Tools unless 
you disable it. To enable EUCON in other DAWs, see the documentation provided by the manufacturer, as well as the 
EUCON Application Setup Guide.pdf. 

To enable EuControl in Pro Tools:

1 Launch Pro Tools. If the Quick Start dialog appears, close it.

2 Choose Setup > Peripherals, and click the Ethernet Controllers tab. 

3 Select Enable EUCON. 

4 Click OK. You do not need to configure any other Ethernet Controllers settings. These settings do not apply to EUCON. 

Pro Tools scans your system until it identifies attached EUCON-compatible hardware. When Pro Tools finishes scanning your 
system, your controllers are ready to use with Pro Tools.

5 Proceed to Confirming EUCON.

Enable EUCON check box

While Pro Tools is connected to a EUCON surface do not uncheck to disable and re-check to enable without a complete restart 
of all components (surfaces and Pro Tools computer) after disabling and before re-enabling. 
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Confirming EUCON
To confirm installation and communication: 

1 Make sure you have enabled EUCON.

2 Open a session if one is not already open. 

3 Verify that the channel strip displays above the bottom row of 16 encoders (the Channel Encoders) on the S3 show the track 
names for the first 16 tracks in the Pro Tools session. 

4 In the Pro Tools Mix window, verify that the names of the tracks currently banked to the channel strips on S3 are highlighted 
with blue-green borders.

5 Proceed to any of the following:

• For instructions on using your S3 after initial installation, see Powering-On Your System After Initial Setup.

• To connect a second workstation computer, go to Connecting a Second Workstation.

• To connect a footswitch, go to Connecting a Footswitch.

Powering-On Your System After Initial Setup
After the initial installation and setup, your system must be powered on in a specific order, as follows:

1 If connecting to a router, connect S3 to the router, connect the router to the workstation computer, and power on the router.

2 If connecting directly, connect S3 to the workstation computer.

3 Power on the S3.

4 Confirm that S3 is in Studio Mode. Enable Studio Mode if Studio Mode is not enabled (see Toggling Studio and Live Modes).

5 Once S3 is finished initializing, power on the workstation computer.

Channel Encoder displays showing track names (first eight tracks shown)

Pro Tools Mix window showing tracks currently banked to the S3 channel strips

If the S3 is not recognized by EuControl on your workstation computer (for example, because you powered S3 on after pow-
ering on the workstation computer), click the unlit EuControl icon in the menu bar (Mac) or System tray (Win) and choose 
Restart EUCON Applications...to relaunch EuControl and re-initiate the connection.

Kick
Pan

1 Snare
Pan

2 Hats
Pan

3 Rack 1
Pan

4 Rack 2 
Pan

5 Floor
Pan

6 Bass DI
Pan

7 Bass Mic 
Pan

8

rrrrrrrr
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Connecting a Second Workstation
The S3 can control applications running on a second computer that is connected to the same network as the primary computer, re-
ferred to in this guide as a workstation. If EuControl is running on the same workstation as all your audio/video applications you 
can skip these instructions. 

To be able to control a second workstation:

1 Quit (Mac) or Exit (Windows) Pro Tools and any other EUCON applications running on any of your workstations. 

2 Transfer the EUCON_WorkstationUnifiedInstall onto the second computer. After downloading, make sure the installer is 
mounted (DMG on Mac) or uncompressed (ZIP for Windows).

3 Double-click the Install EUCON Workstation Unified installer, then select the EUCON Workstation option and click Next.

4 Follow the instructions on-screen to complete the installation. 

5 When installation has finished, go to Spotlight (Mac) or Search (Windows), and type “MC Client” to locate the application, then 
launch MC Client.

6 On the primary workstation, do each of the following: 

• Open EuControl Settings, go to the Workstations tab, and click to enable Enable External Workstations. Follow the prompt 
and wait until EUCON applications restart. You must also manually relaunch your DAW. 

• Go to System Preferences > EUCON (Mac) or Control Panel > EUCON (Windows). 

• Click the Network Interface selector and choose the port used for your EUCON network connection (such as Ethernet 1).

7 On the secondary workstation, do each of the following: 

• Go to System Preferences > EUCON (Mac) or Control Panel > EUCON (Windows). 

• Make sure the Network Interface selector shows the correct network port for your EUCON connection.

• If it is not already enabled, click to enable Enable as External Workstation. Follow the prompt and wait until EUCON ap-
plications restart. You must also manually relaunch your DAW.

EUCON Workstation selected in EUCON Combined Installer

EUCON Control Panel, Enable as External Workstation 
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8 Open the EuControl Settings window by doing either of the following: 

• On Mac, click the EuControl icon on the taskbar and select EuControl Settings.

• On Windows, double-click the EuControl icon in the system tray and select EuControl Settings. If you don't see the EuCo-
ntrol icon, it could be automatically hidden by Windows. Click on the small white arrow to show hidden icons, then dou-
ble-click the EuControl icon.

9 In EuControl Settings, go to the Workstations tab. 

10 Select your secondary workstation in the All Workstations list, then click Add to add it to the My Workstations list. 

You can now switch between workstations by doing either of the following: 

• On the Dock, S3, or other Artist Series media controller, press the Workstation switch. For example, on the S3 press 
SHIFT+Application/Workstation. 

• In the Workstations tab of EuControl Settings, select the desired workstation in the My Workstations list and click Attach. If 
you are using the Control app without any other Artist Series controllers, you must use this method to switch workstations. 

Connecting a Footswitch
The S3 has a 1/4-inch footswitch input on the back panel, which can be used to punch in and out of recording in your DAW, or for 
engaging talkback. For more information on configuring the footswitch in EuControl for punch in/out or talkback, see the Using 
EuControl Surfaces.pdf.

Footswitch input on the back of S3

When using S3 as an AVB audio interface, a footswitch can be configured for AVB talkback. For more information, see Using 
Talkback.
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S3 Surface Controls Overview

This section provides an overview of the surface controls on the S3 when using S3 with EUCON-compatible applications. For spe-
cific S3 workflows, see the Using EuControl Surfaces.pdf.

S3 top panel

1 – Channel Strips

2 – Channel Strip Displays

3 – Assignable Channel Encoders

4 – Channel Encoder Assignment Switches

5 – Fader Banking Controls

6 – Left Control

7 – Channel Control

8 – View and Arrow Switches

9 – Application/Workstation Switch

10 – Right Control

11 – Solo Clear and Mix to Monitors Switches

12 – Surface SHIFT

13 – Modifier Switches

14 – Touchstrip

1

2

3

4

5

7

8

9

6

13 14 1212

10

11
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Channel Strips
S3 provides 16 channel strips, each with a display, an Assignable Channel Encoder (each with its own encoder 
Sel and In switches), a Solo switch, a Mute switch, a 100mm motorized touch-sensitive fader, a channel select 
(Sel) switch, a record engage (Rec)/Automation Mode (A) switch, and a level meter.

Channel Strip Display
See Channel Strip Displays.

Assignable Channel Encoder
See Assignable Channel Encoders.

Solo
The Solo switch lights yellow when that track is soloed.

Mute
The track is muted (off) when the strip Mute switch is lit, and is on (unmuted) when not lit.

Fader
The fader controls the level for the track assigned to the channel strip, or the parameter assigned to the Channel 
Encoder if Flip to Faders is engaged. It is motorized so it reflects changes made in the application, such as au-
tomation. It is also touch sensitive, which some applications use for automation.

 When the Select by Touch General preference is selected in the EuControl Settings application (see Select 
by Touch), touching a fader selects that track in the application and attentions it on that strip. This is the same 
as pressing the fader Sel switch. 

 Holding down the Default/ALT switch and touching a fader sets it to unity gain.

Channel Sel and Rec Switches
Each channel strip features a channel Sel, a channel Rec switch, and an automation mode switch (A), which operate as follows:

Sel Selects that track in the application, and attentions it for editing in the Channel Encoders when Channel Mode is enabled (see 
Channel Encoder Modes), and in Channel Control (see Channel Control). A line under the track name in a channel strip display 
indicates the track is attentioned.
.

Rec Record-enables a track in the application. 

• In Pro Tools, the Rec switch flashes red to indicate that track is enabled (armed) for recording, and is lit solid when recording 
is in progress.

• Pressing a lit Rec switch disables that track for recording.

A (Surface SHIFT + Rec) Changes the automation mode for a track.The desired automation mode appears in the bottom 
right-hand corner of the channel strip display or on-screen.
.

In Pro Tools and other applications, multiple tracks can be selected, but only one channel can be attentioned. In this case, the at-
tentioned track is the last one selected.

You can swap the primary and SHIFT functions of the REC/A switch in the General tab of EuControl Settings. For more infor-
mation, see General. You can also use the Function (F1–F16) switches to change track automation modes. See Working with 
Automation.
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Channel Strip Displays
At the top of each channel strip is an Organic Light Emitting Diode (OLED) display. When S3 is first powered on, the Channel En-
coders are in Normal Mode (see Channel Encoder Modes), and each display shows track information as follows:

1 – Meter Shows clip, peak, and normal values. It can show mono, stereo, or surround tracks. 

2 – Track Name Shows the track name as it appears in the application. When a fader is touched, it shows the value of the fader. Af-
ter releasing the fader it reverts to showing the track name.

3 – Track Number Shows the track number relative to its position in the application.

4 – Parameter Name Shows the name of the parameter currently assigned to the corresponding Channel Encoder. When an en-
coder is touched, it shows the value of the parameter. After releasing the encoder it reverts to showing the parameter name.

5 – Encoder Position Shows the relative setting of the control for the currently assigned parameter. 

6 – Automation Mode Shows the track’s current automation mode setting, as follows:

7 – Attention Indicator Indicates that the corresponding track is the attentioned track. Any parameters adjusted using the Channel 
Encoders in Channel Mode (see Channel Encoder Modes) and using Channel Control apply to the attentioned track (see Channel 
Control).

Display Sleep

To preserve display life, the channel displays enter sleep mode when not in use. See OLED Dim Time. 

Channel strip display in Normal Mode

Automation Modes and Displayed Indication

Mode Display

Off (blank)

Read r

Touch t

Latch l

Touch-Latch tl

Write W

Trim

For more information on working with automation on the S3, see Working with Automation.
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Assignable Channel Encoders
Each channel strip has one touch-sensitive, continuously rotating encoder for adjusting parameters as assigned by the Channel En-
coder Assignment switches (see Channel Encoder Assignment Switches). Each encoder can also be pressed, which is typically 
used to access sub-menus. Each encoder also has corresponding Sel and In switches.

• A Channel Encoder Sel switch assigns a secondary function of the displayed parameter to the corresponding Channel En-
coder. For example, engaging the Sel switch for an encoder controlling EQ frequency assigns Q (bandwidth) to that encoder.

• A Channel Encoder In switch toggles two-state parameters, such as turning an individual EQ Band on/off.

Channel Encoder Modes
The Channel Encoders operate in either Normal Mode or Channel Mode. The channel displays shows the current channel mode.

Normal Mode

In Normal Mode, each Channel Encoder controls the same parameter for every track on the channel strips. A line appears under the 
attentioned track’s name in the display.

Channel Mode

In Channel Mode, the 16 Channel Encoders control up to 16 different parameters for the attentioned track. In Channel Mode pa-
rameter names and value are highlight in each channel display. For the attentioned track, track name as well as parameter and value 
are highlighted. 

Channel Mode is useful for editing EQs and plug-ins that have many parameters. 

Basic Channel Encoder Use
When S3 is first powered on, the Channel Encoders are in Normal Mode and Pan is assigned to the Channel Encoders by default. 
Each Channel Encoder controls pan for its corresponding track on the strip.

To quickly access pan control on the Channel Encoders in Normal Mode:

 Press the Pan Channel Encoder Assignment switch.

To enable Channel Mode: 

1 Press a Channel Sel switch to attention that track, then press SHIFT + Flip. 

2 Press the desired channel Encoder Assignment switch

3 To exit Channel Mode, press Shift + Flip again.

Channel displays in Normal Mode, showing “Snare” as the attentioned track

Channel displays in Channel Mode, showing “Snare” as the attentioned track

Pressing the EQ Channel Encoder Assign Switch automatically enables Channel Mode as well.
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Channel Encoder Assignment Switches
The Channel Encoder Assignment switches assign sets of adjustable parameters, called Knob Sets, to the Channel Encoders. A 
Knob Set is an array of controls used by EuControl-compatible applications to control plug-ins, EQs, dynamics, aux sends, and 
other processing functions using the controls on the S3. Some of these Knob Sets also have sub-menus.

One of the switches is always selected, and the associated parameters are assigned to the Channel Encoders until another Channel 
Encoder Assignment switch is pressed. When S3 is first powered on, Pan is selected by default.

The labels next to each Channel Encoder Assignment switch indicate the parameters that can be assigned to the Channel Encoders. 
The text in white represents a switch’s primary function, and the text in black represents a switch’s secondary function. Secondary 
functions are accessed by pressing and holding the Surface SHIFT switch (see Surface SHIFT) then pressing the desired Channel 
Navigation switch.

The following switches are provided:

Input Assigns hardware input parameters such as input routing, mic gains, phantom power, and other application-specific param-
eters to the Channel Encoders.

Insert Assigns the top-level Insert Knob Set to the Channel Encoders. When Insert is pressed, in each channel display for all cur-
rently banked tracks the first insert slot (a) is shown, or a plug-in is shown if one is inserted. Pressing a Channel Encoder under the 
display showing the plug-in you want to adjust enables Channel Mode on the Channel Encoders, and the Knob Set for the selected 
plug-in is assigned to the 16 Channel Encoders for editing. 

 Press the Page > Channel Encoder Navigation switch to access the next plug-in.

 Press the Back Channel Encoder Navigation Switch to return to the Channel Encoders to the top-level Inserts Knob Set. Or, you 
can simply press another Channel Encoder Assignment switch to navigate directly to another Knob Set. 

Dyn Assigns the top-level Dynamics Knob Set to the Channel Encoders. Operation is similar to the Inserts Knob Set, except only 
the first inserted Dynamics plug-in on the channel is displayed and accessed. 

Channel Encoder Assign switches

Primary function (Insert) and the secondary function (Dyn)

The text on the switch itself indicates the parameter that can be assigned to the Channel Encoders when using S3 as part on 
an S3L live system.

Use the Audio Control Encoders to control the S3’s built-in I/O. See S3 Audio I/O for more information.

In the Insert Knob Set, parameters are mapped to the Channel Encoders according to the manufacturer’s specifications. Pa-
rameter mapping can vary between plug-ins, even of the same type.

In the Dyn Knob Set, parameter mappings to the Channel Encoders are standardized across dynamics plug-ins. For example, 
the threshold controls for two compressor plug-ins from different manufacturers appear on the same encoder.

Group Channel

Dyn Mix
Insert Pan

Aux Flip

Input EQGain HPF

Comp Pan

Aux Flip

Dyn
Insert

Comp
 S3 Surface Controls Overview 20



Aux Assigns sends on the Channel Encoders.

 In Normal Mode, the first send is displayed, and pressing the Page > Channel Encoder Navigation switch assigns the next set 
of sends to the encoders.

 In Channel Mode, up to 16 sends for the currently selected channel can be accessed at once.

Group Displays the Group Knob Set to configure group or control group (VCA) membership.

 In Normal Mode, the first group is displayed, and pressing the Page > Channel Encoder Navigation switch displays the next 
group if applicable.

 In Channel Mode, up to 16 groups for the currently selected channel can be accessed at once.

EQ Assigns the top-level EQ Knob Set to the Channel Encoders. Operation is similar to the Inserts Knob Set, except only the first 
inserted EQ plug-in on the channel is displayed and accessed.

Pan Displays the Pan Knob Set to configure stereo or surround panning. Pan controls are not available for tracks with mono or no 
output path assignments.

Mix (Surface SHIFT + Pan/Mix) Displays the Mix Knob Set to configure track output routing.

Flip  Toggles what is currently assigned to the knobs (such as pan or send parameters) to the faders. A vertical double arrow appears 
in the channel strip display when the faders and knobs are flipped. Press Flip again to toggle the faders and knobs back to normal. 
You can use Flip mode with Aux sends, for example, to quickly set up headphone mixes using the faders.

Channel (Surface SHIFT + Flip/Channel) Toggles the Channel Encoders between Normal Mode (unlit Channel switch) and 
Channel Mode (lit Channel switch). In Normal Mode, the attentioned track name is underlined to show which track’s parameters 
will be expanded in Channel Mode.

Channel Encoder Navigation Switches
Since a Knob Set may have more parameters than encoders, use these switches to navigate through available parameters.

Back Returns to the previous Knob Set. Press Back repeatedly to back out of all sub-menus and display the top of the current Knob 
Set.

 Source Shows the input sources for the currently banked channels in the channel strip displays.

< Page, Page > Assigns the previous or next set of parameters to the Channel Encoders. The switches light when there is a previ-
ous or next set to go to. For example, if Send A is assigned to the Channel Encoders, pressing Page > assigns Send B to the Channel 
Encoders.

In the EQ Knob Set, parameter mappings to the Channel Encoders are standardized across EQ plug-ins. For example, high 
band gain controls for two EQ plug-ins from different manufacturers appear on the same encoder.

Flip indicator in OLED display

Channel Navigation Switches

Pan
Kick

1

rw

Source
Back

Page Page

Top
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Fader Banking Controls
Bank tracks to the channel strips using the Bank and Nudge switches. Home and End are shortcuts to the first and last banks, re-
spectively.

Bank and Nudge
The Bank and Nudge switches change which tracks are assigned to the channel strips, as follows:

< Nudge Banks tracks one track to the left. If tracks 2–17 were banked to channel strips 1–16, pressing < Nudge once banks tracks 
1–16 to strips 1–16. Pressing < Nudge again banks tracks 1–15 to strips 2–16. 

Nudge > Banks tracks one track to the right. If tracks 1–16 were banked to channel strips 1–16, tracks 2–17 are now banked to strips 
1–16.

< Bank Banks 16 tracks to the left. If tracks 17–32 were banked to strips 1–16, pressing < Bank banks tracks 1–16 to strips 1–16. 
Pressing the switch again does nothing because the first bank is already shown.

Bank > Banks 16 tracks to the right. If tracks 1–16 were banked to strips 1–16, tracks 17–32 are now banked to strips 1–16. 

Mixer and Close
Not all applications support these switches. 

Mixer (Surface SHIFT+ < Nudge/Mixer) Toggles Mix and Edit windows in Pro Tools. 

Close (Surface SHIFT + Nudge >/Close) Closes any open window in the application.

Home and End

Home (Surface SHIFT + < Bank/Home)  Banks tracks 1–16 to the channel strips.

End (Surface SHIFT + Bank >/End) Banks the last set of tracks to the strips. 

Fader Navigation controls

The Bank and Nudge switches are also used when Working with VCAs to spill VCAs in Multi-Master mode. 

Mixer Close

Home End

Nudge Nudge

Bank Bank
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Left Control

Switches A–F
By default, these switches let you recall custom fader banks and layouts, as created and stored using the Layouts and Assign tabs 
of the EuControl Settings application. You can recall up to 12 custom fader layouts using switches A–F. A–F recall mixer layouts 
1–6. The Shift layer (Surface SHIFT + Bank A–F) recalls layouts 7–12. See Storing and Recalling Custom Layouts for more 
information. 

You can also customize these switches in EuControl. See Soft Keys for more information.

OK and Cancel Switches
Multi Assign Performs the Do to Selected command. For example, use this to create a send or insert a plug-in on all selected tracks. 
See Assigning Sends for an example.

OK Confirms and closes dialogs, and is the equivalent of pressing the Enter key on a computer keyboard.

Cancel Closes dialogs without making any changes, and is the equivalent of pressing the Escape key on a computer keyboard.

User Saves the current session. 

To save the current session:

1 Press User.

2 Press User again to confirm, or press Cancel to not save.

Left Control

Pressing and holding Surface SHIFT + Multi Assign performs the Do to All command. Use this to create a send or insert a 
plug-in on all tracks in the session.

Multi
Assign

User

OK

Cancel

A

B

C

D

E

F
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Channel Control
The top row of 16 encoders and associated navigation switches is called Channel Control. Channel Control lets you adjust a variety 
of parameters for the currently attentioned track. Channel Control and the bottom-row Channel Encoders operate independently, 
so you can adjust two sets of parameters for a single channel. You can also access controls for the S3’s built-in I/O using Channel 
Control (see S3 Audio I/O for more information).

Each Channel Control Encoder features a corresponding display, a select (Sel) switch, an In switch, and a color-by-function LED. 
Four Channel Control Navigation switches are provided for navigating through parameters. 

Channel Control Navigation Switches (Left)
These switches let you navigate through the available pages of Channel Control parameters. An In (enable/bypass) switch is also 
provided.

The following switches are provided:

Back/Top Backs out of the currently assigned Knob Set.

In Toggles in/out whatever is assigned to the Channel Control Encoders, such as sends and plug-ins. A lit switch indicates that the 
send or plug-in is in.

< Page, Page > Assigns the previous or next page of parameters. These switches light when there is a previous or next set to go to. 

Channel Control showing the top-level Channel Control Knob Set (I/O controls are hidden)

Channel Control Navigation switches

Surface SHIFT + Back/Top returns Channel Control to the top-level Channel Control Knob Set.

 Inserts
1Kick

   Input      Dyn       EQ     Sends Pan Groups Mix 
Top Config
Back

PageExpnd
Page

Expnd

Top In
Back

Page
Page
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Channel Control Navigation Switches (Right)
These switches provide access to Config mode and the controls for the built-in I/O in Channel Control.

Config Enables Config mode on the Channel Control Encoders, letting you assign plug-ins to tracks, and assign track and send in-
put and output paths. See the Using EuControl Surfaces.pdf for more information.

< Page, Page > Lets you show/hide the Audio Control (controls for the built-in I/O) on the Channel Control Encoders when 
pressed simultaneously. I/O controls are hidden by default. See Accessing Audio Control on the S3 for more information.

Basic Channel Control Use
When S3 is first connected to a session in your DAW, the top-level Knob Set for the currently selected channel is shown in the 
Channel Control displays. The types of parameters that can be spilled to the Channel Control Encoders vary depending on the type 
of channel selected (audio track, instrument track, etc.).

To adjust parameters using Channel Control:

1 Select a track. If multiple channels are selected, the last selected track is the attentioned track, and is the targeted channel for any 
changes made in Channel Control. The name of the attentioned track and its track number is shown in the leftmost Channel Con-
trol display.

2 Press a Channel Control Encoder under the display showing the parameters you want to adjust. For example, to adjust an EQ 
plug-in inserted on the currently selected channel, press the Channel Control Encoder under the display showing EQ.

The parameters are spilled across the top 16 encoders, and the LEDs light to reflect the currently assigned function.

3 To go to a different Knob Set, press the Back Channel Control Navigation switch to return to the top-level Knob Set, then press 
another Channel Control Encoder.

Channel Control LED Color-Coding
Channel Control LEDs are color-coded by function, as follows: 

Config switch and I/O Controls

Channel Control top-level Knob Set, showing the attentioned track in the leftmost display

Channel Control Functions and Corresponding LED Colors

Function Color Function Color

Insert Turquoise (blue/green) Sends Yellow

Input Red Pan Blue

Dyn Green Groups Orange

EQ Purple Mix Amber

Top Config
Back

PageExpnd
Page

 Inserts
1Kick

   Input      Dyn       EQ     Sends Pan Groups Mix 

Attentioned track
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View and Arrow Switches
By default, these switches provide recall of Memory Locations, and zoom controls. You can also customize these switches in Eu-
Control. See the Using EuControl Surfaces.pdf for more information.

View 1 and View 2 Recall Memory Locations 1 and 2 respectively. If no Memory Locations exist, these switches do nothing.

▲ ▼ Adjust vertical zoom (track height) of all tracks in the Timeline display of the Edit window.

◄ ► Adjust horizontal zoom (zoom in/out) of all tracks in the Timeline display of the Edit window.

Application/Workstation Switch
This switch lets you cycle through the available applications and workstations.

Application Toggles between the two most recently used open applications. Hold down Application and press Bank > to cycle 
through all open applications. Hold down the Application key and press < Bank to cycle through applications in the opposite di-
rection.

Workstation (Surface SHIFT + Application/Workstation) Attaches the S3 to another workstation, where applicable. S3 can con-
trol applications running on a second computer, referred to in this guide as a workstation. You must first use EuControl to create 
a list of workstations that this key switches between. See the Using EuControl Surfaces.pdf for more information.

Solo Clear and Mix to Monitors Switches

These switches provide the following functions:

Solo Clear Clears any currently soloed channels.

Mix to Mons Is not currently implemented for DAW use.

Window Navigation controls

Application/Workstation switch

Solo Clear and Mix to Monitors switches

View 1 View 2

Solo
Clear

Mix to
Mons
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Right Control
By default, switches F1–F8 (F9–F16) provide control over the automation mode for one or more selected tracks in two banks of 
switches. You can also customize these switches in EuControl. 

See the Using EuControl Surfaces.pdf for more information.

The following table shows the default function of each switch in this section.

To set the automation mode on a single track:

 Press and hold the Function switch for the desired Automation Mode, then select a channel.

To set the automation mode on multiple tracks:

1 Select multiple channels.

2 Press and hold Multi-Select/SHIFT+ ALT, then press the switch for the desired Automation Mode.

The Function Switch LED lights whenever its respective automation mode is selected. In certain automation modes such as Write, 
the LED flashes.

Automation Controls

Switch Automation Function Switch Automation Function 

F1 Write F2 Read

F3 Touch F4 Automation Off

F5 Latch F6 Automation Match 

F7 Trim F8 Automation Window

F9 Preview F10 Write to All/Selected

F11 Punch Preview F12 Write to Start

F13 Capture F14 Write to End

F15 Punch Capture F16 Write to Next

9–16
Toggles switches between banks 
F1-F8 and F9-F16

Show Me 
(Eye Icon)

Opens EuControl Settings > Soft Keys > 
Right Control section

1
9

2
10

3
11

4
12

5
13

6
14

7
15

8
16

9-16
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Surface SHIFT
Some switches have secondary functions, highlighted in gray above the primary function (such as < Bank/Home, where Home 
is the secondary function). To access these secondary functions, use either of the two Surface SHIFT switches located at the 
lower-left and lower-right sides of the console surface. SHIFT can be engaged momentarily or latched on.

To engage Surface SHIFT momentarily:

 Press and hold the Surface SHIFT switch.

By default, the Surface SHIFT switch operates in momentary behavior (active only while pressed and held down). You can change 
this to operate in Latching behavior (pressing and releasing quickly toggles the state on or off) by enabling Latching Shift. This set-
ting is located in the Miscellaneous section of the Preference tab in EuControl Settings. 

Modifier Switches
The Modifier switches provide frequently used shortcuts that can be applied to console actions and software screen interactions. In 
Pro Tools, these switches duplicate the function of the Pro Tools computer keyboard modifiers.

Multi Select/SHIFT Duplicates the function of the Shift key on the computer keyboard.

Default/ALT Duplicates the function or the Option key (Mac) or the Alt key (Windows) on the computer keyboard. 

Fine/CTRL Duplicates the function of the Control key (Mac) or the Windows key (or Start) on the computer keyboard.

Command Duplicates the function of the Command key (Mac) or the Control key (Windows) on the computer keyboard.

Touchstrip
By default, the four Touch strip Zones provide transport controls. 

You can also customize these switches in EuControl. See the Using EuControl Surfaces.pdf for more information.

To use the Transport:

1 Press and hold Surface SHIFT.

2 Press the following Zones for the various transport functions:

1 (Rewind) Rewinds until released.

2 (Fast Forward) Fast forwards until released.

3 (Play/Stop)  Engages play when the transport is stopped; stops the transport when play is engaged.

4 (Record Arm) Arms the transport for recording.

Surface SHIFT switch

Global Modifier switches

Transport controls

SHIFT

Multi Select
SHIFT

Default
ALT

Fine
CTRL Command

1 2 3 4
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S3 Audio I/O

This chapter shows how to use the built-in audio I/O on the S3, including:

Enabling S3 Audio on the Workstation Computer
To use the audio I/O on your S3 with your workstation computer, you must first enable the audio connection on the workstation 
computer. This connection only needs to be enabled the first time you connect the S3 to a particular computer.

To enable S3 audio on your workstation computer:

1 Connect S3 to your workstation computer.

2 Power on S3, and make sure the S3 is in Studio mode (see Toggling Studio and Live Modes for more information).

3 Power on your workstation computer.

4 On your computer, go to Applications > Utilities > Audio MIDI Setup and from the Window menu, choose Show Network De-
vice Browser.

5 Click the checkbox next to Avid S3. If more than one device appears and both are checked, deselect the other device. Once 
checked, the S3 appears in the list of available audio devices in the Audio Devices Window of the Audio MIDI Setup.

6 Launch Pro Tools, and from the Setup menu choose Playback Engine.

7 From the Playback Engine pop-up, choose Avid S3:AVB.

8 Choose Setup > IO Setup. Click Default on both the Input and Output tabs, then click OK to close IO Setup.

• Enabling S3 Audio on the Workstation Computer

• Direct Out Mode

• S3 Audio Connections Overview

• Accessing Audio Control on the S3

• Connecting and Adjusting Inputs

• Connecting and Adjusting Outputs

• Connecting Hardware Inserts

• Connecting and Adjusting Headphones

• Saving S3 Monitor Settings

At the time of this writing, using S3 as an AVB audio interface is only supported on Mac. 

S3 Surface shown in the Network Device Browser (left) and the Audio Devices Window (right) of the Audio MIDI Setup

For other DAWs, see the documentation for the application to configure its I/O settings.

Choosing the S3 as the Playback Engine for Pro Tools
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Direct Out Mode
S3 Audio Control provides Direct Out mode on a per input basis. This lets you use the S3 in the following ways: 

Standalone Mixer You can send any S3 audio input to any S3 audio output, letting you use S3 as a 4-in/6-out mixer. 

Zero-Latency Monitoring While recording through S3, use Direct Out mode to route S3 input(s) to your main monitor outputs. In 
Pro Tools, mute the track you are recording to. Use the S3 encoder for Direct Out Level as a mix knob to balance input level with 
your main mix. This is similar to the Mix Knob on Mbox and other similar audio interfaces. 

Note: Low-Latency Monitoring in Pro Tool is not supported with S3.

Talkback  Any input can be set to be the S3 Talkback input. Talkback can be engaged (momentary or latched) using the Mix to 
Mons switch, or the User switch and/or a footswitch. For more information, see Using Talkback. 

Direct Out Mixer QuickStart
1 Make sure the S3 is in Studio mode (see Toggling Studio and Live Modes for more information).

2 Simultaneously press the right-side < Page and Page > Channel Control Navigation switches to access Audio Control.

3 Hold the Surface SHIFT switch then press the encoder for any Audio Control input. 

Direct Out controls for that input channel are shown in its encoder display.

4 To assign the input to an available S3 audio output, press the encoder Sel switch. 

Each press cycles the assignment to the next available output (such as All, Out 1–2, Out 1, Out 2, or None). Any stereo or mono 
output can be chosen. 

5 Rotate the encoder to set the Direct Out level. 

6 Press the encoder to mute the Direct Out signal.

Avoiding Double-Monitoring 

If you do not plan on using Direct Out mode for zero-latency monitoring or for talkback, but are planning on using S3 Audio Con-
trol for DAW/AVB monitoring, do the following to ensure that no audio is routed twice to your monitoring outputs: 

1 Make sure to assign None as the output for all S3 audio inputs. 

2 Save the Audio Control settings (see Saving S3 Monitor Settings). 

Encoder display for an S3 audio input showing Direct Out Mode

DirOut
Talkback 10dB

ALL
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S3 Audio Connections Overview
S3 provides four channels of analog inputs to Pro Tools or other Core Audio-compatible applications that support sample rates of 
48 kHz, and four channels of analog outputs for connecting monitors and other outboard audio devices.

1 – Inputs 1–2 (2 x XLR)
Inputs 1–2 are balanced microphone inputs, and are adjusted using the In 1 and In 2 Channel Control Encoders. Phantom power (48 
Volts) and a 20 dB pad are provided on each input. Inputs 1–2 can be linked. See Connecting and Adjusting Inputs for more in-
formation.

2 – Inputs 3–4 (2 x 1/4-inch TRS)
Inputs 3–4 are line-level inputs that accept balanced TRS and unbalanced TS connections. Inputs 3–4 operate at a nominal level of 
+4 dBu, and are adjusted using the Line 3 and Line 4 Global Control Encoders. A 20 dB pad is provided on each input. Inputs 3–4 
can be linked.

3 – Outputs 1–2 (2 x XLR)
MAIN

Outputs 1–2 are the main monitoring output pair for your audio/video application, and operate at a nominal level of +4 dBu. Con-
trols for Outputs 1–2 are linked and are adjusted using the Main Channel Control Encoder. By default the monitor source for Out-
puts 1–2 are Out 1–2 from Pro Tools or other DAWs. Outputs 1–2 are active when Select is highlighted in the MAIN Channel Con-
trol Encoder display. See Connecting and Adjusting Outputs for more information.

4 – Outputs 3–4 (2 x 1/4-inch TRS)
ALT

Outputs 3–4 are an alternate monitoring output pair and operate at a nominal level of +4 dBu. Outputs 3–4 accept balanced TRS 
and unbalanced TS connections. Outputs 3–4 are linked and are adjusted using the ALT Global Control Encoder. By default the 
monitor source for Outputs 1–2 are Out 1–2 from Pro Tools or other DAWs. Outputs 3–4 are active when Select is highlighted in 
the Alt Channel Control Encoder display. Track outputs can also be routed to Outputs 3–4 independently in Pro Tools. 

5 – Headphone Output (1 x 1/4-inch Stereo TRS)
Headphone volume is adjusted using the volume wheel along the front edge of the S3. When the Mon to HP monitor preference is 
enabled, the headphone output mirrors Outputs 1–4 on the S3. Track outputs can also be routed to the Headphone output inde-
pendently, and correspond to Out 5–6 in Pro Tools. See Connecting and Adjusting Headphones for more information

S3 control surface back panel audio connections

48V and the 20 dB pad can only be changed for inputs 1–2 when the Monitor Source is set to AVB 1–2 or In 3–4. For more in-
formation, see Changing the Monitor Source.

The monitor source for the MAIN and ALT outputs can be changed using the Mon Prefs encoder. See Changing the Monitor 
Source for more information.

2

5

14 3
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Accessing Audio Control on the S3
Audio Control–the S3’s built-in I/O controls–are adjusted using Channel Control Encoders 9–16. Audio Control is hidden by de-
fault.

To access Audio Control:

 Simultaneously press the right-side < Page and Page > Channel Control Navigation switches.

Controls for the built-in I/O are assigned to Channel Control Encoders 9–16.

Single Display Mode
Single Display mode lets Audio Control be focused on one single encoder (Channel Control encoder 16) instead of across eight en-
coders.

To enable Single Display Mode: 

1 Hold Surface SHIFT switch and press <Page + Page> switches simultaneously to toggle between Single Display Mode and 
Full Display Mode. 

2 While in Single Display Mode, use the <Page and Page> switches to bank through each Audio Control page. 

Connecting and Adjusting Inputs
You can adjust inputs using the Channel Control Encoders. You can also link Inputs 1–2 and 3–4 and control each pair using a sin-
gle Encoder and associated switches.

To connect and route a mic or line input: 

1 Connect a microphone to Inputs 1–2; connect a line-level device to Inputs 1–4.

2 In your audio/video application, assign S3 hardware inputs to the desired track(s). In Pro Tools, inputs on the S3 are called In 
1–4 in the Input Path selector.

Right-side < Page > switches

I/O controls in Channel Control

Choosing an S3 Input in Pro Tools

Top

In

Sel

Config
Back

PageExpnd
Page

48v
Pad

48v
Pad

48v
Pad

48v
PadIn 1

10dB
In 2

10dB
In 3

10dB
In 4

10dB
Select
Cut

ALT
-65dB

MON
PrefsTB Engage=

Mix to Mon

AVB 1-2
MON to HP Cut

MAIN
-65dB

Select
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To adjust inputs:

1 If necessary, access Audio Control by simultaneously pressing the < Page and Page > Channel Control Navigation switches.

2 Do any of the following under the display showing the input you want to adjust:

• To adjust input gain, rotate the encoder. 

• To engage the 20 dB pad, press the encoder Sel switch so its LED is lit green and Pad is highlighted in the display.

• To engage 48v (phantom power) on Mic/Line Inputs 1–2, press the encoder In switch so its LED is lit red and 48v is high-
lighted in the corresponding display.

Inputs 1–2 and Monitor Source

When Inputs 1–2 are designated as the Monitor Source, the 20 dB pad is automatically engaged and 48V disengaged. These settings 
can only be changed when the Monitor Source is set to either AVB or to Inputs 3–4. For more information, see Changing the Mon-
itor Source.

To link and unlink input pairs:

1 To link input pairs 1–2 or 3–4, press and hold Multi-Select/SHIFT, then press the Encoder under the display showing In 1 or 
In 2 to link 1–2, or In 3 or In 4 to link 3–4.

2 To unlink an input pair, press Multi-Select/SHIFT + the encoder under the display showing In 1-2 or In 3-4. 

Using Talkback
Any input can be assigned as the Talkback input. Talkback can be engaged (momentary or latched) via the Mix to Mons switch, 
User switch and/or a footswitch.

To assign the Talkback input source: 

1 Access Direct Out mode by holding SHIFT and pressing the encoder for the S3 input you want to assign as Talkback input. 

2 Press the encoder In switch to assign that input as the Talkback input (Talkback becomes lit).

Example Talkback setup: 

1 Connect your Talkback mic to S3 Input 1.

2 Hold surface SHIFT and press the encoder for S3 input 1, then in the Direct Out settings for Input 1, enable Talkback. 

3 Press the encoder Sel switch to cycle through and assign Input 1 (talkback) to an S3 audio output.

4 If using a secondary audio interface such as an HD OMNI, you can connect the assigned S3 talkback output to an HD OMNI 
input. In Pro Tools, route that input to a desired Cue send output. 

Encoder displays showing linked Input controls

Encoder display for an S3 audio input showing it assigned as the Talkback input source

You could also route that HD OMNI input to an audio track and record it to use it as a Slate input. 

48v
Pad In 1-2

10dB 48v
Pad In 3-4

10dB

DirOut
10dB

ALL
Talkback
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To configure Talkback preferences: 

1 Define how you want Talkback activated by rotating the encoder under TBEngage= and choosing one of the following:

• Mix to Mons

• User (Engaging User for Talkback makes the User switch inaccessible to EuControl as a Soft Key)

• Footswitch (Engaging footswitch for Talkback makes the footswitch inaccessible to EuControl for record/play operations)

• User/Footswitch

To set polarity for footswitch Talkback engage: 

1 Configure Talkback Engage for Footswitch or User/Footswitch. 

2 Press the In switch below the TBEngage encoder to show polarity options. 

3 Rotate the encoder to choose between normally open or normally closed to match your footswitch type.

4 Press Sel to save Talkback settings. 

Connecting and Adjusting Outputs
You can toggle the monitor source between Outputs 1–2 (MAIN) and Outputs 3–4 (ALT), adjust the monitor level, and dim and 
mute (Cut) the outputs using the Channel Control Encoders. The default source for S3 Outputs 1–4 (and the Headphone output if 
MON to HP is selected) is Out 1–2. However, you can also assign tracks to S3 outputs independently.

You can also sum an output pair to mono and change the monitor source for the outputs.

To connect and route and outputs

1 Connect an audio destination such as audio monitors to Outputs 1–2 (Main) or Outputs 3–4 (Alt).

2 In your audio/video application, assign track outputs to the desired S3 hardware output(s). In the Pro Tools Output Path selector, 
Out 1–2 corresponds to S3 Outputs 1–2 (MAIN), Out 3-4 corresponds to S3 Outputs 3–4 (ALT), and Outs 5–6 correspond to 
the S3 Headphone output.

To adjust outputs:

1 If necessary, access Audio Control by simultaneously pressing the < Page and Page > Channel Control Navigation switches.

2 To adjust an output pair, do any of the following under the display showing the output you want to adjust:

• To make an output pair (Main or Alt) active, press the corresponding encoder Sel button so it is lit. Select is highlighted in 
the corresponding display, and the LED above the display is lit green for the currently selected output pair.

• To toggle an output pair on/off, press the corresponding encoder In switch. The output pair is off (Cut) when the button is lit. 
Cut is highlighted in the corresponding display, and the LED above the display is flashes red.

• To adjust the output level, rotate the encoder. The relative level in dB is indicated in the display.

• To dim the output, press the encoder. Dim is shown in the display, and the LED above the display is lit orange.

Choosing S3 Outputs in Pro Tools

To make both output pairs active, press Multi Select/SHIFT + Encoder Sel of the unselected pair. To make only one output pair 
active, press the desired output pair's Sel switch.
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To sum an output to mono:

1 Press and hold Multi-Select/SHIFT.

2 Press the Encoder for the output pair you want to sum to mono. Mono appears in the corresponding display. Mono signals are 
sent equally to each physical output in the pair.

3 Repeat to return to stereo operation.

Changing the Monitor Source
You can change the monitor source for the outputs on the S3 using the Monitor Preferences (Mon Prefs) encoder. 

To change the monitor source:

1 If necessary, access Audio Control.

2 Under the display showing Mon Prefs, press the encoder Sel switch to select an available monitor source as follows:

AVB 1–2 When AVB 1–2 is selected and appears in the display, Out 1-2 from Pro Tools and Core Audio are routed to Outputs 1–4 
on the S3 (and the Headphone output if MON to HP is selected). This is the default monitor source setting for the S3.

In 1–2 When In 1–2 is selected and appears in the display, Inputs 1–2 on the S3 are routed to Outputs 1–4 on the S3 (and the Head-
phone output if MON to HP is selected). Use this to monitor an external source such as an audio interface or other playback device.

When Inputs 1–2 are designated as the Monitor Source, the 20 dB pad is automatically engaged and 48V disengaged. These settings 
can only be changed when the Monitor Source is set to either AVB 1–2 or to In 3–4. For more information, see Changing the Mon-
itor Source.

In 3–4 When In 3–4 is selected and appears in the display, Inputs 3–4 on the S3 are routed to Outputs 1–4 on the S3 (and the Head-
phone output if MON to HP is selected). Use this to monitor an external source such as an audio interface or other playback device.

Connecting Hardware Inserts
Inputs 3–4 and Outputs 3–4 can be used to insert external hardware on tracks in your application. When inserting hardware, be sure 
to connect the device to matching inputs and outputs on S3. For example, to insert a mono device, connect the input of the device 
to Output 3 on S3, then connect the output of the device to Input 3 on S3.

Connecting and Adjusting Headphones
Use the front panel Headphone volume control to control overall Headphone volume. By default the stereo Headphone output mir-
rors the other outputs on the S3, but this can be disabled.

To toggle Headphone output mirroring:

1 If necessary, assign I/O controls to Channel Control.

2 Under the display showing Mon Prefs, press the corresponding encoder In switch. When Mon to HP is unlit, the Headphone out-
put no longer mirrors Outputs 1–4. 

Mon Prefs encoder and display

In Pro Tools, inserts are defined in the IO Setup. Go to Setup > IO..., then click the Insert tab to define the session insert paths. 
See the Pro Tools Reference Guide for more information.

MON
Prefs

AVB 1-2
MON to HP
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Saving S3 Monitor Settings
You can save the current monitor settings on your S3, including monitor preference settings, and MAIN (Outputs 1–2) and ALT 
(Outputs 1–2) settings.

To save the current monitor settings:

1 Make any desired adjustments to the monitor settings on the S3.

The 13th Channel Control display (TBEngage) displays Save. If you have engaged Single Display Mode, use the < Page and 
Page > switches to navigate the single Channel Control display (16) to TBEngage/Save. 

2 Press the lit Encoder Sel switch. 

Saving Settings...appears in the display until saving is complete. Settings are saved until the next time you save.

Audio Control display showing Save

48v
Pad In 4

10dB
MON
PrefsTB Engage=

Mix to Mon

AVB 1-2
MON to HP

Save
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Specifications

All specifications subject to change.

S3 Control Surface Audio Specifications
S3 Analog Mic Inputs, Pad Disabled

Parameter Conditions
Value

UnitsMin. Typ. Max.

Phantom Power 48 Volts

Input Sensitivity @ 997 Hz, Gain = 10 dB (min.) +7.979 dBu

Equivalent Input Noise (EIN) Gain = 60 dB, 150  source impedance -126.1 dB

Frequency Response VINPUT = -12.035 dBu, 20 Hz – 20 kHz relative to 
1 kHz, Gain = 10 dB (min.)

-0.021 0 -0.236 dB

Dynamic Range Unweighted 150  source impedance, Gain = 10 dB (min.) -111.2 dB

Dynamic Range A weighted 150 source impedance, Gain = 10 dB (min.) -113.8 dB

THD+N Amp  @ 997Hz, Gain = 40 dB 0.0014 %

THD+N Freq measured at -25.242 dBu, 20 Hz – 20 kHz,
Gain = 40 dB

0.0007 0.0014 0.0045 %

Common Mode Rejection 
Ratio

VINPUT = -21.560 dBu, 20 Hz – 20 kHz, 
Gain = 10 dB (min.)

-71.7 -80.8 -81.4 dB

Inter-channel Crosstalk VINPUT = -12.150 dBu, 20 Hz – 20 kHz, 
Gain = 10 dB (min)

-120.4 -109.6 -99.2 dB

Input Impedance @1 kHz 3.5K ohms
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S3 Analog Mic Inputs, Pad Enabled

Parameter Conditions
Value

UnitsMin. Typ. Max.

Phantom Power 48 Volts

Input Sensitivity @ 997Hz, Gain = 10 dB (min.) +28.322 dBu

Frequency Response VINPUT =+8.225 dBu, 20 Hz – 20 kHz relative to 

1 kHz, Gain = 10 dB (min.)

-0.016 0 -0.235 dB

Dynamic Range Unweighted 150  source impedance, Gain = 10 dB (min.) -111.2 dB

Dynamic Range A Weighted 150  source impedance, Gain = 10 dB (min.) -113.9 dB

THD+N Amp  @ 997 Hz, Gain =40 dB 0.0018 %

THD+N Freq measured at -3.808 dBu, 20 Hz – 20 kHz, 
Gain = 40 dB

0.0012 0.0018 0.0064 %

Common Mode Rejection Ratio VINPUT = -1.276 dBu, 20 Hz – 20 kHz, 

Gain = 20 dB

-59.3 -63.8 -63.9 dB

Inter-Channel Crosstalk VINPUT = +8.233 dBu, 20 Hz – 20 kHz, 

Gain = 10 dB (min.)

-122.1 -109.1 -98.2 dB

Input Impedance @1 kHz 3.7k ohms

S3 Analog Line Inputs

Parameter Conditions
Value

UnitsMin. Typ. Max.

Input Sensitivity @ 997Hz, Gain = 10 dB (min.) +18.471 dBu

Equivalent Input Noise (EIN) Gain = 18 dB, 150source impedance -93.9 dB

Frequency Response VINPUT =-1.520 dBu, 20 Hz – 20 kHz relative to 

1 kHz, Gain = 10 dB (min.)

-0.018 0 -0.233 dB

Dynamic Range Unweighted 150  source impedance, Gain = 10 dB (min.) -110.4 dB

Dynamic Range A weighted 150  source impedance, Gain = 10 dB (min.) -113 dB

THD+N Amp  @ 997Hz, Gain =40 dB 0.0010 %

THD+N Freq measured at +12.193 dBu, 20 Hz – 20 kHz, 
Gain = 40 dB

0.0005 0.0010 0.0016 %

Common Mode Rejection Ratio VINPUT = -1.523 dBu, 20 Hz – 20 kHz, 

Gain = 0 dB

-64.4 -66.8 -67.0 dB

Inter-Channel Crosstalk VINPUT = -1.520 dBu, 20 Hz – 20 kHz, 

Gain = 0 dB (min.)

-117.8 -110.1 -98.3 dB

Input Impedance @1 kHz 5.1k ohms
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S3 Control Surface Mechanical Specifications

S3 Analog Outputs

Parameter Conditions
Value

UnitsMin. Typ. Max.

Output Sensitivity @ 997 Hz +24.201 dBu

Output Impedance @1 kHz 103.5 ohms

Residual Output Noise 20 Hz – 20 kHz -88 dBu

Round Trip Latency Console input to Console output 3.2 ms

S3 Headphone Output

Parameter Conditions
Value

UnitsMin. Typ. Max.

Output Impedance  @1 kHz 1 ohms

Output Sensitivity 32 load @ 997 Hz, max output +17.932 dBV

Max RMS Power Output +20.157 dBu 32 ohm headphones 
+19 dBu 600 ohm headphones

1.940
163.1

mW

Parameter Specification

Height (front)
Height (back)

1.3 inches (32.0 mm)
2.8 inches (71.7 mm)

Maximum Width 28 inches (711.11 mm)

Maximum Depth 14.3 inches (363.11 mm)

Weight 13.8 lbs (6.2 kg)

Power Requirements 100–240 V, 50–60 Hz, 200 W

Power Connectors External PSU AC Input: IEC, 3-pin North American standard
External PSU DC Output: Kycon KPPX–4P; 12V, 7.5A max current

Audio Connectors (x8) XLR3–M balanced (x2), XLR3–F balanced (x2), 
1/4-inch TRS balanced (x4)

Headphone Connector 1/4-inch TRS unbalanced

Network Connectors (x2) RJ-45 Neutrik etherCON

USB Ports (x2) USB 2.0 (for connecting mouse and keyboard only)

Footswitch Connector 1/4-inch TRS

Light Connectors (x2) XLR3–F, LED console light required
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Dimensions

 28 in
(711.1 mm)

 14.3 in
(363.1 mm)

2.2 in
(57.3 mm)

.6 in
(14.4 mm)

1.8 in
(45.2 mm)

 

 1 in
(25.4 mm) 

1.3 in
(32 mm)

2.85 in
(71.7 mm) 
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Appendix A: Compliance Information

Environmental Compliance

Disposal of Waste Equipment by Users in the European Union

This symbol on the product or its packaging indicates that this product must not be disposed of with other waste. Instead, it is your responsibility to dispose of your waste 
equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste 
equipment at the time of disposal will help conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more 
information about where you can drop off your waste equipment for recycling, please contact your local city recycling office or the dealer from whom you purchased the 
product.

Proposition 65 Warning

Perchlorate Notice
This product may contain a lithium coin battery. The State of California requires the following disclosure statement: 
“Perchlorate Material – special handling may apply, See www.dtsc.ca.gov/hazardouswaste/perchlorate.”

Recycling Notice

EMC (Electromagnetic Compliance)
This model Pro Tools | S3 complies with the following standards regulating interference and EMC:
• FCC Part 15 Class B
• EN 55022 Class B
• EN 55024 Class B
• AS/NZS CISPR 22 Class B
• CISPR 22 Class B

This product contains chemicals, including 
lead, known to the State of California to 
cause cancer and birth defects or other re-
productive harm. Wash hands after handling.
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FCC Compliance for United States

Radio and Television Interference

Australian Compliance

Canadian Compliance
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

CE Compliance
(EMC, Safety, and ROHS)

Avid is authorized to apply the CE (Conformite Europenne) mark on this compliant equipment thereby declaring conformity to EMC Directive 2004/108/EC, Low Voltage 
Directive 2006/95/EC and RoHS Directive 2011/65/EC.. 

Korean EMC Compliance

이 기기는 가정용 (B 급 ) 전자파적합기기로서 주
로 가정에서 사용하는 것을 목적으로 하며 , 모
든 지역에서 사용할 수 있습니다 .

Communication Statement
NOTE: This equipment has been tested and found to comply with the 
limits for a Class B digital device, pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio communications. However, there 
is no guarantee that interference will not occur in a particular 
installation.  If this equipment does cause harmful interference to radio 
or television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try and correct the 
interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from 

that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.
Any modifications to the unit, unless expressly approved by Avid, 
could void the user's authority to operate the equipment.
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Safety Compliance

Safety Statement
This equipment has been tested to comply with USA and Canadian safety certifications in accordance with the specifications of UL Standards: UL60950-1:2007, 2nd Edition 
and canadian CAN/CSA C22.2 60950-1-07, 2nd Edition. Avid Inc. has been authorized to apply the appropriate UL and CUL mark on its compliant equipment. 

Warning

Important Safety Instructions

1) Read these instructions.

2) Keep these instructions.

3) Heed all warnings.

4) Follow all instructions.

5) Do not use this equipment near water.

6) Clean only with dry cloth.

7) Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.

8) Do not install near any heat sources such as radiators, heat registers, stoves, or other equipment (including amplifiers) that produce heat.

9) Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two 
blades and a third grounding prong. The wide blade or the third prong are provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for 
replacement of the obsolete outlet.

10) Protect power cords from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit from the equipment.

11) Only use attachments/accessories specified by the manufacturer.

12) For products that are not rack-mountable: Use only with a cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the equipment. When a cart is 
used, use caution when moving the cart/equipment combination to avoid injury from tip-over.

13) Unplug this equipment during lightning storms or when unused for long periods of time. 

14) Refer all servicing to qualified service personnel. Servicing is required when the equipment has been damaged in any way, such as power-supply cord or plug is damaged, 
liquid has been spilled or objects have fallen into the equipment, the equipment has been exposed to rain or moisture, does not operate normally, or has been dropped.

15) For products that are a Mains powered device: 
The equipment shall not be exposed to dripping or splashing and no objects filled with liquids (such as vases) shall be placed on the equipment. 

Warning! To reduce the risk of fire or electric shock, do not expose this equipment to rain or moisture. 

16) For products containing a lithium battery: 
CAUTION! Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type. 

17) For products with a power switch: 
The main power switch is located on the back panel of S3. It should remain accessible after installation. 

18) The equipment shall be used at a maximum ambient temperature of 40° C.
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Technical Support (USA)
Visit the Online Support Center 
at www.avid.com/support
Product Information
For company and product information, 
visit us on the web at www.avid.com
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